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What Is Clocker? 

 Clocker is an event-scheduler program, which will execute pre-determined events at a 
specific time.    Clocker is extremely useful for running unattended backups, running after-
hours processes such as downloading or faxing, and many other things -- limited only by 
your imagination!    Clocker can also pop up user-defined reminder messages, so it can 
function as an alarm clock. 

 Clocker also has the capability for group scheduling on a network.    The system 
administrator can place a group schedule on a shared disk, and each machine running 
Clocker on the network will optionally read this file, in addition to its private schedule file.    
This group schedule is also automatically refreshed, so the administrator can make a change
once and every machine using that group schedule will be automatically updated to reflect 
the changes.    This can be extremely useful for tasks ranging from network backups to 
broadcast meeting notices. 



Clocker Command Line 

 The command line for Clocker is: 

 clocker [privatefile] [groupfile] 

 where privatefile is a private Clocker data file and groupfile is a group Clocker data file. Note
that the order of these parameters is not important -- Clocker will auto detect the file type. 

 Also note that these command line parameters will override the Load Files on Startup 
feature. 



File Menu 

 The File menu contains commands for opening, saving, and closing Clocker data files. 

 Open... 
 Close 
 Save 
 Save As... 

 Open Group... 
 Close Group 
 Save Group 
 Save Group As... 

 Exit 



Options Menu 

 The Options menu contains commands for adding, editing, and deleting items which are in 
the list(s) of events. 

 Add Item 
 Edit Item 
 Delete Item 

 Add Group Item 
 Edit Group Item 
 Delete Group Item 



Settings Menu 

 The Settings menu provides options which change the way information is handled, 
displayed and reported by Clocker. 

 Font 
 Delete After Execute 
 Print Log 
 Display Date 
 Display Group 
 Load Files On Startup 



Help Menu 

 The Help menu provides on-line help and information about Clocker. 



Open File 

 This menu selection opens a private Clocker data file.    These files usually have a .CLK 
extension. 

 An error message will be printed if you try to open a group file using this command. 



Close File 

 This menu selection closes an open private Clocker data file.    The event list in memory will 
be cleared. 



Save File 

 Choosing this option allows you to save the current private Clocker data file. The file will be 
saved with the same name it was opened with, or if the file was just created, you will be 
prompted for a name for the file. 



Save File As 

 Choosing this option allows you to save the current private Clocker data file. You will be 
prompted for a name for the file. 



Open Group File 

 This menu selection opens a group Clocker data file.    These files usually have a .CLK 
extension. 

 An error message will be printed if you try to open a private file using this command. 



Close Group File 

 This menu selection closes an open group Clocker data file.    The event list in memory will 
be cleared. 

 Choosing this command will also exit Supervisor mode for the group file. 



Save Group File 

 Choosing this option allows you to save the current group data file. The file will be saved 
with the same name it was opened with, or if the file was just created, you will be prompted 
for a name for the file. 

 Choosing this command will also exit Supervisor mode for the group file. 



Save Group File As 

 Choosing this option allows you to save the current group data file. You will be prompted for 
a name for the file. 

 Choosing this command will also exit Supervisor mode for the group file. 



Exit 

 Exits Clocker.    If any schedules have been modified, you will be prompted to save them 
before Clocker closes. 

 Note that a schedule file could have been modified if the Delete After Execute option is on. 



Add Schedule Item 

 This command is used to enter a new schedule item into the private schedule.    For detailed
information, see Edit dialog. 



Edit Schedule Item 

 This command is used to edit a schedule item in the private schedule.    For detailed 
information, see Edit dialog. 



Delete Schedule Item 

 To delete an item from the private schedule, simply select the item by clicking on it and 
choose this menu option.    The event will be removed from the list. 



Add Group Schedule Item 

 This command is used to enter a new schedule item into the group schedule. 

 If there is no group schedule currently loaded, you will be prompted for a new password for 
this group schedule.    This password will be stored with the file when you save it and it will 
be required whenever you want to make changes to the file. 

 If there is currently a group schedule loaded, and you are not currently in Supervisor mode ,
you will be prompted for the password for this group schedule. Without the proper password,
you cannot alter the group schedule.    If you enter the password correctly, you will enter 
Supervisor mode . 

 For detailed information on adding a new schedule item, see Edit dialog. 



Edit Group Schedule Item 

 This command is used to edit a schedule item in the group schedule. If you are not currently
in Supervisor mode , you will be prompted for the password for this group schedule. Without 
the proper password, you cannot alter the group schedule.    If you enter the password 
correctly, you will enter Supervisor mode . 

 For detailed information on editing a schedule item, see Edit dialog. 



Delete Group Schedule Item 

 This command is used to delete a schedule item from the group schedule.    To delete an 
item, select the item by clicking on it and choose this menu option. If you are not currently 
in Supervisor mode , you will be prompted for the password for this group schedule. Without 
the proper password, you cannot alter the group schedule.    If you enter the password 
correctly, you will enter Supervisor mode . 



Edit Schedule Item Dialog 

 When you choose to add or edit a private or group schedule item, you need to enter the 
following information about your event into the form: 

 Date 
 Specifies the date the event is to be executed.    This date can carry slightly different 
meanings, depending on the other settings as described below. 
 The date must be entered in the following format: MM/DD/YY. 

 Time 
 Specifies the time the event is to be executed. 
 The time can be entered in either 12-hr or 24-hr format.    To use 24-hr format, enter the 
time in the form HH:MM.    If you want to enter it in 12-hr, use the form HH:MMa or HH:MMp, 
for AM or PM respectively. 

 Repeat 
 Specifies if the event is to be repeated multiple times on the days it runs. 
 To specify that an event should repeat, click the repeat box.    Then fill in the two boxes to 
the right of the repeat box -- these are the repeat interval and the end time.    The event 
should then execute every [repeat interval] minutes until [end time]. 
 For example, if you wanted an event to execute every hour from 9:00am to 5:00pm, you 
would enter 9:00a as the start time, 60 as the interval, and 5:00p as the end time. 

 One Day Only 
 Specifies that the event should only occur on the date specified.    Note that this repeat 
mode allows you to use the Delete After Execute command, if you wish. 

 Repeat Daily/Weekly 
 Specified that the event should occur every week, on the specified days of the week. When 
this option is used, the date field is ignored. 

 Repeat Monthly 
 Specified that the event should occur every month, on the day of the month specified.    For 
example, if the specified date is 3/31/92 and the Repeat Monthly option is checked, then the 
event would execute on the 31st of every month. 
 Note that no check is made for dates that do not occur in every month; hence in the above 
example, the event will never execute in February since February does not have 31 days. 

 Command Line 
 To run a program at the specified time(s), select this option and type the command line of 
the program you wish to run below it. 
 Note that the browse button is available for selecting the desired file.    Also note that file 
associations (set up with the Windows File Manager) are supported. 

 Message 
 Select this option if you want to pop up a reminder message at the desired time instead of 
running a program.    Type the message you want in the area below this button. 

 Specify Working Directory 



 If you wish to specify a working directory, select this option and enter it in the area below.    
Note that this option is only available when the Command Line option is selected. 

 Normal 
 Select this option if you want to run a program in a normal window. 

 Iconized 
 Select this option if you want to run a program as an icon. 

 Hidden 
 Select this option if you want to run a program hidden.    Be careful with this option, as you 
will not be able to give user input to the program.    Also be sure to have a valid .PIF file with 
Background Execution enabled to run DOS programs hidden. 

 Test 
 Clicking the Test button will test the entry you have made, whether it is a command line or 
a message. 



Changing Font 

 Select this menu item to change the font used for the current date and time, the time 
displayed in the icon, and the font used for the status line. 



Delete After Execute 

 If this option is checked, any One Day Only events which do not repeat (ie. will only execute
once) will be deleted from the list after they are executed.    This feature is most useful for 
one-time message boxes, such as a reminder for a meeting, etc. 



Print Log File 

 When this item is checked, a log file will be maintained which logs every program which was
run and the error code, if any. 

 This log file will be called CLOCKER.LOG, and will be stored in your Windows directory. 



Display Date 

 When this item is selected, the current date will appear next to the time in the Clocker 
window.    When iconized, the date will become part of the title line (ie. Clocker - 11/17). 



Display Group 

 If there is a group schedule active, you have the option of displaying it or not. If you do 
display it, it will be shown on the bottom half of the Clocker window. 

 Note that regardless of whether or not the group schedule is displayed, the status line will 
still reflect the group file status, and the group shedule will still be active (if there is one 
loaded). 



Load Files on Startup 

 If this option is selected, Clocker will start in the state it was in when last exited -- the file(s) 
which were loaded will be loaded again on startup. 

 Note that both private and group files will be automatically loaded if this option is selected 
and both were active when Clocker was previously exited. 

 Also note that any command line parameters will override the automatic load feature. 



Using Private and Group Files 

 Private Files 
 Each machine running Clocker can have its own private schedule.    This schedule should 
contain events which are unique to that machine.    For example, if a user wanted to get a 
reminder before a meeting, or download a file after hours, this would most likely be in the 
private schedule.    Also, any stand-alone (not networked) should only use a private file in 
most cases. 

 Private schedules are read once at the beginning of the session. 

 Group Files 
 Group schedules are central schedules which multiple machines read.    These schedules are
password protected and should be stored on a shared network disk, which is readable by all 
machines using the group schedule. 

 Each machine will automatically refresh its internal schedule from the group file. So, the 
system administrator can make a schedule, and edit it several times during the day and all 
of the machines reading this schedule will be automatically updated within minutes (see 
Advanced Options ). 

 Group files are password protected for security reasons.    When a group file is created, a 
password must be specified for it.    Any attempt to edit this file in the future will require the 
correct password.    If the password is correctly entered, Clocker will enter Supervisor mode . 



Other Options 

 Icon Always On Top 
 This option is available from the system menu.    This makes Clocker stay on top of all other 
windows when it is iconized. 



Advanced Options 

 Note: these options are intended for advanced users and network administrators only. They 
should not be necessary for normal use of Clocker. 

 Time Update Interval 
 This option changes the frequency with which Clocker updates its internal time. The default 
is 5 seconds, which should be adequate for most uses.    However, with this default, events 
executed and the time displayed by Clocker could be up to 5 seconds late. 

 To change this value, create a [Settings] section in the CLOCKER.INI file (which should be in 
your Windows directory), if there is not one already. Add the following line, under this section
header: 

 TimeUpdateInterval=5 

 Instead of 5, enter the interval in seconds you want.    Note that the interval must be 
between 1 and 59 seconds.    Smaller numbers will slightly increase overhead, but this effect 
will probably not be noticeable. 

 Group Refresh Rate 
 This option changes the frequency with which Clocker refreshes the group file. The default is
every 15 minutes, which should be adequate for most uses. 

 To change this value, create a [Settings] section in the CLOCKER.INI file (which should be in 
your Windows directory), if there is not one already. Add the following line, under this section
header: 

 GroupRefreshRate=15 

 Instead of 15, enter the refresh rate (in minutes) that you want.    The actual refresh times 
will be when (minutes MOD interval) is zero -- for example, if the GroupRefreshRate is 15 
minutes, then refreshes will take place at 0, 15, 30, and 45 minutes past the hour.    Note 
that smaller intervals can increase overhead, both within Clocker and on the network (since 
all of the machines will probably be hitting the file server simultaneously). 



Supervisor Mode 

 To edit a group file, you must be in supervisor mode.    To get into supervisor mode, you 
must enter the correct password for the group file you are trying to edit. After you enter the 
password once, and enter supervisor mode (as reflected on the status line), you will have 
the capability to add, edit, and delete group schedule items. 

 To exit supervisor mode, you must either save the group file, close the group file, or open a 
new group file. 

 Be careful not to remain in supervisor mode longer than necessary, for security reasons -- 
the capability to run processes on someone else's machine is a powerful one.    Also note 
that while you are in supervisor mode, the machine you are using will not update its group 
schedule from disk until you exit supervisor mode. 



Support Information 

 Support will be available via telephone, E-mail or US Mail.    All inquiries from registered 
users will be acknowledged; non-registered user inquiries will be handled as time permits. 

 Telephone 
 (303) 484-7204 

 E-mail 
 CompuServe: 71774,605 
 Internet: 71774.605@compuserve.com 

 US Mail 
 Winnovation 
 P.O. Box 271071 
 Ft. Collins, CO    80527-1071 



Ordering Information 

 The registration fee for Clocker 2.0 is $24.95, for a single-user license.    Site license rates 
shown in ORDERFRM.TXT. 

 To order, fill out ORDERFRM.TXT and send it to: 

 Winnovation 
 P.O. Box 271071 
 Ft. Collins, CO    80527-1071 




